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Page 4 Index ......... . . 75 GL-1010 Network Fax Operator’s Guide...

Page 5: Preface
Introduction Optional Network Fax Feature Congratulations on purchasing TOSHIBA’s Optional
Network Fax Feature for the e-STUDIO Electronic Document Processing System. Both products
incorporate the latest in state-of-the-art digital and computer technology. When the Fax and
Address Book software is installed, the digital copier becomes an all-inclusive network printer
with remote LAN and fax capability.

Page 6: Intended Audience
This guide is not intended for digital copier service technicians or operators. For information on
using and maintaining the TOSHIBA digital copier, refer to the Toshiba Operator’s Guide for
Copying Functions or contact your Toshiba authorized dealer for support. Scope This guide
assumes that you are familiar with the software applications you are using to create your
documents for printing.

Page 7 Light blue and Indicates text that is linked on Click the Install Software link at the
underlined a web page. This text is not bottom of the page. linked in the documentation.
GL-1010 Network Fax Operator’s Guide...

Page 8 GL Fax Driver from printing to the fax driver to selecting fax recipients. Chapter 5, GL-
FAX Address Book Viewer on page 55 summarizes how to use the GL-Address Book, from adding
contacts and groups to importing and exporting address book database information. GL-1010
Network Fax Operator’s Guide...

Page 9: Supplemental References
In addition to the information in this guide, the following reference materials are available to
assist you in using and optimizing your controller: Toshiba Operator’s Guide for Copying
Functions This manual describes the digital copier functions: how to make copies, maintain the
copier, and troubleshoot mechanical and copying problems.

Page 10 All of the Electronic Document Processing System software and drivers come with
application-specific online help. Click or choose the Help options from the Help menu. For web-
based help in Contents and Index TopAccess, click the link. Help viii GL-1010 Network Fax
Operator’s Guide...

Page 11: Overview
Overview TOSHIBA’s Network Fax Option for the digital copier with the e-STUDIO Electronic Data
Processing System simplifies and facilitates your office facsimile needs by enabling you to fax
digital documents directly from your desktop. GL-1010 Network Fax Operator’s Guide...

Page 12: Functional Highlights
The GL-Fax driver is complimented by the GL-Fax address book viewer. This combination of
applications lets you manage a selection of fax recipients and access the TOSHIBA Address
Book. Software Components Note: Faxing hard copy documents must be performed as a walk-
up function at the copier control panel.

Page 13 Select and view recipient fax numbers and other contact information Import or
export address book data to and from other address book programs GL-1010 Network Fax
Operator’s Guide...

Page 14 GL-1010 Network Fax Operator’s Guide...

Page 15: Installation
This chapter includes procedures for installing the software that enables fax printing and online
address book functions for the digital copier. TOSHIBA recommends that you read these
instructions in their entirety before beginning the installation process. GL-1010 Network Fax
Operator’s Guide...
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Page 16: Installing The Network Fax Kit
Installing the Network Fax Kit Before you can begin using the TOSHIBA optional Network Fax
Feature for the e-STUDIO system, you must install the software using the e- STUDIO Fax Client
CD-ROM provided. Use the InstallShield client software setup process. This section describes
several ways to add the fax driver to a user’s workstation.

Page 17 Follow the setup wizard as it leads you through the installation steps. You are
prompted to supply the following information: Enter a destination directory or accept the default
location, which is C:\Program Files\GL-1010\Toshiba e-STUDIO GL-Fax & Address Book. Select
the...

Page 18 Deselect the checkbox if you want, and then click to exit the Finish Setup Wizard. If
you select a new file location, the directory name must conform to the DOS 8.3 naming
convention of an eight-character file name and a three-character file extension. GL-1010
Network Fax Operator’s Guide...

Page 19 Verify the installation by selecting the from the TOSHIBA GL Address Book TOSHIBA
e-STUDIO GL Client program group. If the GL-Address Book Editor does not open, repeat Steps
1-5. Adding Printers The following procedure varies for Windows 9x, Windows Me, Windows NT,
Windows 2000, and Windows XP.

Page 20 Next Add Printer Wizard -- Select Printer by Manufacturer and Type Click Next Click
Have Disk Place the e-STUDIO Fax Client CD-ROM in the CD-ROM drive and select the CD-ROM
drive in the dialog box. GL-1010 Network Fax Operator’s Guide...

Page 21 Note: If the Add Printer Wizard detects previously installed software, you are
prompted to either keep or replace the existing driver. If the controller software has been
updated recently, TOSHIBA recommends that you replace the driver. Otherwise keep the
existing driver.

Page 22: Installing From Topaccess
Installing from TopAccess If the system administrator has uploaded the software to the
controller, users can install the software on their workstations by downloading it from the
controller through TopAccess. Open TopAccess from your workstation. GL-1010 Network Fax
Operator’s Guide...

Page 23: Uninstalling The Driver
Insert the e-STUDIO Fax Client CD-ROM into the CR-ROM drive. If AutoRun is enabled, the
InstallShield Setup Wizard runs automatically. Otherwise, choose from the Start menu and then
locate the setup.exe file on the CD-ROM. GL-1010 Network Fax Operator’s Guide...

Page 24 Follow the instructions in the setup wizard as files are removed from your system.
Click to exit the setup program. Finish You may need to reboot your system before all
components, such as the program items from the Windows Start menu, are completely
removed. GL-1010 Network Fax Operator’s Guide...

Page 25: Setup
Before you use the fax capability of the system, you should set up several options including:
Sender Information Your Address Book Mailboxes for incoming fax routing This chapter explains
how to customize your fax capability for your specific needs. GL-1010 Network Fax Operator’s
Guide...

Page 26: What Are Fax Properties
So, to continue with the above example, if the page setup indicates a portrait orientation, and
you select the landscape property within the driver, the document is printed in portrait mode.
GL-1010 Network Fax Operator’s Guide...

Page 27: Setting Fax Properties
Groups. The right pane displays the members of the selected group or if the Toshiba e-STUDIO
GL Address Book is selected, all of the members of the entire address book. Selecting a group in
the left pane displays all the members of the selected group in the right pane.
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Page 28 For document size, A4, B4, A3, LT, LG Computer, LD, and Folio, are acceptable
original sizes. The size of the originals that can be sent is determined by (negotiation?)
annotation with the destination fax. Once the fax communication is negotiated, the size of the
original is converted GL-1010 Network Fax Operator’s Guide...

Page 29 Contact Properties dialog allows users to enter all the contact information for a fax
recipient such as a Prefix, First Name, Last Name, Display, Suffix, Company, Department, Fax
Number, E-mail Address, Use Sub Address and Password (check box), Sub Address, Password,
and Notes. GL-1010 Network Fax Operator’s Guide...

Page 30 The Cover Sheet property page lets users send a cover sheet with a fax
transmission. The cover sheet is merged with the recipients in the list in the Send page to
create a final fax cover sheet. Users can select what to GL-1010 Network Fax Operator’s
Guide...

Page 31 Reference Number: click to enable the reference number text box and to include the
reference number on the cover sheet. If you want to include a reference number, enter the
number in the text box. GL-1010 Network Fax Operator’s Guide...

Page 32: Setting Up Mailboxes For Incoming Fax Routing
? : For jobs with an unknown or undefined sub address, shown as ? (Unregistered) These system
mailboxes cannot be deleted but their properties, except the mailbox number, can be edited.
Using these special mailboxes, users can GL-1010 Network Fax Operator’s Guide...

Page 33 Creating a New Mailbox To set up a mailbox for incoming fax routing: Click the tab.
Click the submenu. Mail Boxes Fax Tab -- Mail Boxes Page GL-1010 Network Fax Operator’s
Guide...

Page 34 New Password If you checked the checkbox in Step 6, type Password protect this
template the same password into the text box. Confirm Password Select any notification options
and enter an e-mail address. GL-1010 Network Fax Operator’s Guide...

Page 35 File Name - Type in the filename you want for the incoming fax GL-1010 Network Fax
Operator’s Guide...

Page 36 Return E-mail Address - Enter an e-mail address or e-mail addresses separated by
commas To - Enter an e-mail address or addresses separated by commas or click the link to
select from the address book Subject - Enter a subject GL-1010 Network Fax Operator’s Guide...

Page 37 Message Fragmentation - Select the desired fragmentation E-mail Agent Settings -
Bottom of Screen iFax From (Your Name) - Enter your name Return E-mail Address - Enter an e-
mail address or e-mail addresses separated by commas GL-1010 Network Fax Operator’s
Guide...

Page 38 Message Fragmentation - Select the desired fragmentation iFax Agent Settings -
Bottom of Screen TopAccessComposer TopAccessComposer Folder - Enter the folder name
where the routed fax is to be deposited. The folder may or may not exist. GL-1010 Network Fax
Operator’s Guide...

Page 39 FTP Server Port - Enter the FTP server port number User Name - Enter the user name
for the account that has access to the FTP server Password - Enter the password for the account
that has access to the FTP server GL-1010 Network Fax Operator’s Guide...

Page 40 File Path - Enter the file path to the directory where you want the fax sent File Name
- Enter the file name for the fax File Format - Select the file format from SinglePage TIFF (G4) ,
or MultiPage TIFF (G4) GL-1010 Network Fax Operator’s Guide...

Page 41 Editing an Existing Mailbox To edit a mailbox for incoming fax routing: Click the tab.
Click the submenu. Mail Boxes GL-1010 Network Fax Operator’s Guide...

Page 42 New Password If you checked the checkbox in Step 6, type Password protect this
template the same password into the text box. Confirm Password Select any notification options
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and enter an e-mail address. GL-1010 Network Fax Operator’s Guide...

Page 43 23 for details of setting the agent settings. 11 When you have finished editing the
mailbox, click to enable your changes or to return to the Mail Boxes page without changing
Cancel the mailbox. GL-1010 Network Fax Operator’s Guide...

Page 44 GL-1010 Network Fax Operator’s Guide...

Page 45: Faxing
Print to the fax driver. Add recipients’ names and fax numbers. Select a default cover page
(optional). Send the fax. Note: Faxing hard-copy documents must be performed as a walk-up
function from the digital copier control panel. GL-1010 Network Fax Operator’s Guide...

Page 46: Using The Network Fax Function
Consult your Setup Options user documentation if you are unsure. Properties button Print Dialog
Box (Microsoft Word) The GL-Fax Driver main dialog box opens, with the Send tab displayed.
GL-1010 Network Fax Operator’s Guide...

Page 47 The following sections summarize the options included on each tab. Selecting
Recipients You must specify at least one recipient in order to fax a document. Choose from the
File menu. Print Click Properties GL-1010 Network Fax Operator’s Guide...

Page 48 Note: You can select multiple recipients from the list. You can also select multiple
groups as recipients. If a group is selected as a recipient, all members of the group are added to
the recipient list. GL-1010 Network Fax Operator’s Guide...

Page 49 . The New Contact dialog box opens. New... New Contact Dialog Box Complete the
fax recipient’s contact information. Optionally, check the check box to add the recipient Add to
Address Book to the address book. GL-1010 Network Fax Operator’s Guide...

Page 50: Removing Recipients
If you inadvertently added one or more fax recipients to the list, Send To you can remove them.
From the Send page, select the recipient whom you want to remove from the list. Send To Click
Remove That person is removed from the fax transmission. GL-1010 Network Fax Operator’s
Guide...

Page 51 Original Paper Size Scale To Action Rotate 90 Rotate 90 Statement Letter Rotate 90
Smaller A5 or Statement Add white lines Larger then A3 Reduce to A3 Larger then Ledger
Ledger Reduce to Ledger GL-1010 Network Fax Operator’s Guide...

Page 52 , or Standard Business Professional Cover Sheet Style Fax Driver Properties: Cover
Sheet Tab Enter the subject title to be printed on the cover sheet in the Subject field. The
maximum field length is 40 characters. GL-1010 Network Fax Operator’s Guide...

Page 53 Properties Fax Driver Properties -- Sender Information Tab On the Sender
Information tab, enter the information to be included on the cover sheet. The maximum field
length is 500 characters. Click to save your settings. GL-1010 Network Fax Operator’s Guide...

Page 54 For example, if the current date is March 31st, then the maximum date that can be
selected for the scheduled fax is April 30th. Click . The Scheduled Time dialog box opens. Edit...
GL-1010 Network Fax Operator’s Guide...

Page 55 To send the fax, click . The fax job is sent to the Driver. You can monitor the fax job
using TopAccessDocMon or TopAccess. For further information, refer to the online help for these
applications. GL-1010 Network Fax Operator’s Guide...

Page 56: Managing Faxes
For information on installing and configuring TopAccessDocMon, refer to the Operator’s Guide.
Right-click the TopAccessDocMon taskbar icon to access the taskbar menu. Select TOSHIBA GL-
FAX TopAccessDocMon Select TopAccessDocMon. GL-1010 Network Fax Operator’s Guide...
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Page 57 Document From the drop-down menu, select Cancel Retrieving Routed Fax
Documents (TWAIN) When routed fax data is saved on the controller, it can be retrieved through
a TWAIN-compliant software application. For example, the GL-1010 Network Fax Operator’s
Guide...

Page 58 Select Source Window Click This section describes how to use the GL TWAIN Driver
to import routed fax data. Refer to the TOSHIBA e-STUDIO TWAIN Driver online help for further
information. Note: The TWAIN scanned data directory is: \\<Controller Name>-...

Page 59 If a password is required for the mailbox, the field is Folder Password enabled. Enter
the 5-digit password in the text box. Note: Refer to the TWAIN Driver online help for further
information. Click . The document list opens. GL-1010 Network Fax Operator’s Guide...

Page 60 * : The folder status is unknown. The document is protected. If a selected document
is assigned a password, a dialog box opens prompting you to enter the password. Enter the
password. 10 To change the folder, click and select a new folder. Change Folder GL-1010
Network Fax Operator’s Guide...

Page 61 The first document is created without the number, and the second becomes
DOCNAME-001. You can specify the document name in the Routed Fax MailBox through
TopAccess. Any characters that cannot be used for a file name are replaced with the underscore
character (_). GL-1010 Network Fax Operator’s Guide...

Page 62 Viewing Fax Jobs Start your web browser. Enter the TopAccess URL (the controller
name or IP address) and press ENTER Note: Avoid running multiple instances of TopAccess,
because invalid information may be displayed. GL-1010 Network Fax Operator’s Guide...

Page 63 Select the Fax Jobs page. Select the fax print queue to view: , or Current Delayed
Check the check box next to the fax(es) that you want to delete. Click . The software prompts to
confirm your deletion. Delete GL-1010 Network Fax Operator’s Guide...

Page 64 Click TopAccess: Fax Jobs Page TopAccess deletes the fax from the queue. GL-1010
Network Fax Operator’s Guide...

Page 65: Gl-Fax Address Book Viewer
GL-FAX Address Book Viewer You can manage detailed information about the people you
communicate with by using the TOSHIBA GL-Fax Address Book. You can use the information
stored in the address book to specify fax recipients and compose fax cover pages.

Page 66: Overview
Programs > TOSHIBA e-STUDIO GL Client > TOSHIBA GL Address Book. Access Using Print
Properties From the Print Properties window, you can make limited changes to contact details in
the Toshiba GL-Fax Address Book. For further information, refer to Adding a New Recipient on
page 39.

Page 67: Navigating The Address Book
The GL-Fax Address Book Editor main window consists of two panes. GL-Fax Address Book Main
Window The left-hand pane contains a tree structure for the Toshiba address book. You can
expand or collapse the tree to view or hide groups and contact entries.

Page 68: Managing Your Private Address Book
You can then access these entries from your desktop. Adding Contact Entries Use the function
to create a new contact in the address book. New Contact From the GL-Fax Address Book Editor
main window, select the Toshiba (left pane). GL-FAX Address Book GL-1010 Network Fax
Operator’s Guide...

Page 69 Enter a fax sub address to route or forward a fax to a specific user or fax inbox. The
sub address may consist of numbers between 0 and 9, GL-1010 Network Fax Operator’s Guide...

Page 70: Copying Contacts From An Address Book
Invoke the Properties dialog box by double-clicking the selected contact in the Address Book
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Editor window or by selecting the contact, and then choosing the menu item. Properties From
the GL-Fax Address Book, select the (left Toshiba GL Address Book pane). GL-1010 Network Fax
Operator’s Guide...

Page 71: Creating Groups
The Group Properties page allows you to create groups and define their membership. A group
can have a single member. In the GL-Fax Address Book Editor main window, select the Toshiba
GL- from the list. Fax Address Book Address Book GL-1010 Network Fax Operator’s Guide...

Page 72 In the GL-Fax Address Book Editor main window, select the group to which you want
to add members. Click on the toolbar, select from the menu, or Properties File > Properties
double-click the group name. The Group properties dialog box opens. Click Select Members...
GL-1010 Network Fax Operator’s Guide...

Page 73 The Select Group Members dialog box contains two panes: Contact List: Lists the all
of the contacts and associated information that are currently available in the Toshiba GL-Fax
Address Book. New Member List: Displays the contacts that you have selected to be members
of the group.

Page 74 Select Group Members dialog box. To add a contact who is not listed in the GL-Fax
Address Book, click . For further information, refer to Adding Contact New Contact… Entries on
page 58. GL-1010 Network Fax Operator’s Guide...

Page 75 . A message box opens, asking you to confirm the deletion. Delete Click to
permanently delete the contact or group entry from the address book. Click to exit the message
box without deleting the entry. GL-1010 Network Fax Operator’s Guide...

Page 76 You can also search on all or part of a fax number. Note: The search function applies
to individual contacts, not to groups. Click from the menu. The Find dialog box opens. Edit >
Find Find Dialog Box GL-1010 Network Fax Operator’s Guide...

Page 77 Importing and Exporting Address Book Entries The Import and Export features are
provided with the GL Fax Address Book application. You can import address book data in .csv
file format to, GL-1010 Network Fax Operator’s Guide...

Page 78 The group name contains an invalid character The display name is empty The fax
number is empty The fax number is invalid. Fax numbers are restricted to the following set of
characters: 0-9, +, -, [space], *, # GL-1010 Network Fax Operator’s Guide...

Page 79 Browse for the location to which you are exporting the file. Enter a file name for your
exported address book file. Click to begin exporting the file. The file is created in the location
indicated. GL-1010 Network Fax Operator’s Guide...

Page 80 GL-1010 Network Fax Operator’s Guide...

Page 81: Glossary
Refers to the controller connected to a network digital copier. Often, the term device is used to
refer to the entire controller/copier system. Document Profile A pre-defined set of driver settings
that allows users to auto-configure their print job with a click of the mouse. Network Fax
Operator’s Guide GL-1010...

Page 82 See also Simplex. Electronic This system consists of either the TOSHIBA e-
STUDIO28/35/45 Document digital copier connected to the GL-1010 controller or the TOSHIBA e-
Processing System STUDIO550/650/810 digital copier connected to the GL-1020 controller.
These systems provide the convenience of walk-up copying, scanning, and network printing
from the same device.

Page 83 (i.e., the page width is greater than the height). Printer driver Software installed on
the client workstation that enables printing to a device. The TOSHIBA printer drivers are on the
e-STUDIO Client CD- ROM. They permit printing to the controller. Printer Sticky The paradigm
where actions and/or settings are permanently saved so that they are accessible later.

Page 84 Definitions of Common Terms Term Definition Walk-up functions Operations
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performed from the digital copier control panel. They include standard copying functions,
monitoring network print jobs, and management functions. Network Fax Operator’s Guide
GL-1010...

Page 85: Index
68 changing details 60 public, transferring data 68 copying from address book 60 removing
creating 58 contact 65 editing 60 contact group 65 exporting 69 sorting entries 67 finding in
address book 66 importing 68 GL-1010 Network Fax Operator’s Guide...

Page 86 Finding a contact in address book 66 defined 72 Exporting address book entries 69
Group adding contacts 62 creating 61 agent removing contacts 65 defined 72 removing from
address book 65 see Agents, Send to iFax driver features 2 GL-1010 Network Fax Operator’s
Guide...

Page 87 Send 17 defined 73 Sender 22 NIC 48 Public address book, transferring defined 72
data 68 Mailbox creating 23 editing 31 Recipients adding an unlisted recipient 39 removing
from send list 40 selecting 37 GL-1010 Network Fax Operator’s Guide...

Page 88 Software, installing 6 Sorting contacts in address book 67 TCP/IP, defined 73
Technology Without An Interesting Name see TWAIN TopAccessDocMon deleting fax jobs 47
managing faxes 46 viewing fax jobs 46 Transmission Control Protocol/Internet Protocol see
TCP/IP GL-1010 Network Fax Operator’s Guide...
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